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Molecular dynamics

● to explore conformational space
● to explore biological process of 

molecular recognition
● to investigate ligand pose stability
● to explore protein flexibility 
● to estimate binding affinity of 

protein-ligand (protein-protein) 
complexes

1. MD simulations mimic the physical motions of 
atoms present in the actual environment;

2. The atoms and molecules are allowed to interact 
for a fixed period of time, giving a view of the 
dynamic "evolution" of the system.

https://doi.org/10.1016/j.str.2017.02.009
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https://doi.org/10.1016/j.str.2017.02.009
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Run MD simulation (10 ps):
https://privatecloud.imtm.cz/s/xgUMAHX2iX1TJmg

mkdir md_tutorial_student
cd md_tutorial
conda activate md

pip uninstall streamd
pip install git+https://github.com/ci-lab-cz/md-scripts.git

run_md -p protein_HIS.pdb -l ligand.mol --md_time 0.01 --nvt_time 10 --npt_time 10 --ncpu 8 -d mdrun

https://github.com/ci-lab-cz/md-scripts.git


Classical Molecular Dynamics
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Simulation 
process is 
based on 
Newton’s 
second law
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Theory: force fields
All force fields were developed using different experimental data and for slightly different purposes

The most popular FFs for protein and protein-ligand simulations are:

CHARMM – proteins, lipids, nucleic acids

AMBER – peptide, protein, nucleic acids, lipid14, GAFF

OPLS - optimized to fit experimental properties of liquids, such as density and heat of vaporization

GROMOS – proteins, small molecules, also optimized for experimental parameters
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examples of *.mdp files
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ions.mdp
md.mdp

em.mdp
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To simulate an infinite system, periodic boundary 
conditions are often applied. This allows atoms that 
leave one side of the simulation box to re-enter on the 
opposite side. 

● PBCs are often used in computer simulations 
and mathematical models.

● The topology of two-dimensional PBC is equal 
to that of a world map of some video games; the 
geometry of the unit cell satisfies perfect 
two-dimensional tiling, and when an object 
passes through one side of the unit cell, it 
reappears on the opposite side with the same 
velocity.



Classical Molecular Dynamics
Structure Preparation

Force-field
● Definitions of inter-atomic bonded and 

non-bonded forces (ligand and protein)

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization
● 100 ps
● to ensure that the system has no steric 

clashes or inappropriate geometry

NVT and NPT equilibration
● 1000 ps
● equilibrate the solvent and ions around the 

protein

Product Simulation

Analysis

Preprocessing

Pre-simulation 
steps
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After we got simulated trajectory:

1) Remove Periodic boundary conditions
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Classical Molecular Dynamics



After we got simulated trajectory:

2) Center system (solvate, ions, atoms) over protein

3) Remove rotations of the system

12

Classical Molecular Dynamics



Now you are ready to analyze your trajectory
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Classical Molecular Dynamics
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Metrics
1) Root-mean-square deviation (RMSD):

 the RMSD is a measure of the difference between a initial conformation of the ligand/protein conformation 
and the analysed conformation
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Metrics
 2) Radius of gyration (Rgyr):

Value of Rgyr:

Decreasing - compression

Increasing - extension 



What can be done

● To explore different conformation of protein
○ To investigate internal-flexibility of protein
○ For practical use we select conformations from the most populated clusters of all 

conformations 

Conformation can be used:
- for further molecular docking studyPDB: 1W51
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Increasing of 
Rgyr

Conformer at the 1st ps
Conformer at the 1000th ps



What can be done by MD

● To explore stability of ligand pose

MD 10ns.
Ligand goes out 

of the site

Example of incorrect pose:

PDB: 2WEH

Up to 2 A
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x-ray

docking



What can be done by MD
● to estimate binding affinity of 

protein-ligand complexes
○ Molecular mechanics Poisson–Boltzmann 

surface area (MM/PBSA)
○ Molecular mechanics generalized Born surface 

area (MM/GBSA) 

Valdés-Tresanco, M.S., Valdés-Tresanco, M.E., Valiente, P.A. and Moreno E. gmx_MMPBSA: A New Tool to Perform End-State Free Energy Calculations 
with GROMACS. Journal of Chemical Theory and Computation, 2021 17 (10), 6281-6291. https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645. 
MMPBSA.py: An Efficient Program for End-State Free Energy Calculations  Bill R. Miller III, T. Dwight McGee Jr., Jason M. Swails, Nadine Homeyer, Holger 
Gohlke, and Adrian E. Roitberg  Journal of Chemical Theory and Computation 2012 8 (9), 3314-3321 DOI: 10.1021/ct300418h
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https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645


What can be done by MD
● to estimate binding affinity of 

protein-ligand complexes
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Total GBinding=
● Gas-phase molecular mechanics energy ΔEMM:

○ changes in the internal energies ΔEint (bond, angle, and 
dihedral energies)

○ electrostatic energies ΔEele

○ van der Waals energies ΔEvdW

● sum of the electrostatic solvation energy Gsol
○ The polar contribution is calculated using either the PB 

or GB model (ΔGPB/GB). Where the GB method gives an 
analytical expression for the polar solvation energy and is 
thus much faster than the PB method.

○ nonpolar energy is usually estimated using the 
solvent-accessible surface area (SASA)

● The change in conformational entropy −TΔS 
○ is usually calculated by normal-mode analysis (or 

Interaction entropy) on a set of conformational snapshots 
taken from MD simulations.



GBSA/PBSA We can perform end-state free energy calculations

21
Complex energy terms

Protein energy terms

Ligand energy terms



What can be done by MD

● to estimate binding affinity of protein-ligand 
complexes

○ GBSA/PBSA approach

Valdés-Tresanco, M.S., Valdés-Tresanco, M.E., Valiente, P.A. and Moreno E. gmx_MMPBSA: A New Tool to Perform End-State Free Energy Calculations 
with GROMACS. Journal of Chemical Theory and Computation, 2021 17 (10), 6281-6291. https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645. 
MMPBSA.py: An Efficient Program for End-State Free Energy Calculations  Bill R. Miller III, T. Dwight McGee Jr., Jason M. Swails, Nadine Homeyer, 
Holger Gohlke, and Adrian E. Roitberg  Journal of Chemical Theory and Computation 2012 8 (9), 3314-3321 DOI: 10.1021/ct300418h

Correlation between MM-GBSA 
predicted and experimental 

binding free energy. 

Yang T, Wu JC, Yan C, Wang Y, Luo R, Gonzales MB, Dalby KN, Ren P. Virtual screening using molecular simulations. Proteins. 2011 Jun;79(6):1940-51. doi: 
10.1002/prot.23018. Epub 2011 Apr 12. PMID: 21491494; PMCID: PMC3092865.
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https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645


What can be done by MD

● to investigate protein-ligand 
(protein) interaction stability

23



Beta Secretase

● The best correlation: -0.53
● Results depends on 

parameters but not drastically
● Further analysis may help to 

investigate number of the 
most optimal parameters 

~ time of running
● 1 hour for 10 ns of MD
● 0.5 sec per compound for GBSA

Tested parameters:

● Time of analysis
○ from 1 to 10 ns
○ from 5 to 10 ns
○ from 9 to 10 ns

● GBSA/PBSA methods
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α/β-Tubulin estradiol
 dimers inhibitors
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GBSA PBSA

ID Vmax Gnina VINA 140-150 ns
IE25%

ED 4.2 7.4 -15 -60.81 -16.8

ED3 7.1 8.2 -14.7 -41.30 -2.35

ED5 2.8 8.3 -14.1 -81.59 -24.045

D1 4.1 8.2 -13.7 -70.06 -22.60

D3 7.4 8.0 -13.2 -42.25 -2.88

D9 5.9 8.2 -13.7 -48.5 -5.58

D2 2.8 8.1 -13.2 -65.72 -19.35

Pearson Corr 0.05 -0.03 0.93 0.95



Limitations of Classical Molecular Dynamics:

1) MD simulations on very large systems may require such large computer resources that 

they cannot easily be studied by traditional all-atom methods.

2) Simulations of processes on long timescales* (beyond about 1 microsecond) are 

prohibitively expensive, because they require so many time steps.

3) not accurate calculation of binding energy
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*The microscopic observation of biomolecular processes such as 
protein folding, protein interactions, agonist-antagonist 
functional recognition and enzyme reactions occur on timescales 
ranging from microseconds to seconds. 



Free energy perturbation (FEP)
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Uses for predicting relative binding 
free energy between similar ligands

FEP calculations are based on molecular 
dynamics (MD) simulations and therefore 
explicitly consider both enthalpy and entropy 
effects of the conformational flexibility of the 
ligand, as well as desolvation effects within 
the ligand binding domain (LBD) of certain 
receptors. Simulations must be stable.

perturbationFree Energy Perturbation (FEP) is a computational technique in 
molecular dynamics simulations used to calculate the free energy 
difference between two different states of a molecular system. This 
method is widely employed in computational chemistry and drug 
discovery to understand thermodynamic properties, such as binding 
affinities or conformational changes.

Basic Concept:
Free Energy Difference: FEP aims to 
calculate the free energy difference (ΔG) 
between two states of a system, typically 
denoted as State A and State B. This 
can include changes in conformation, 
solvation state, or interactions with other 
molecules.



Enhanced sampling methods for molecular dynamics simulations
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Enhanced sampling methods in 
molecular dynamics simulations are 
designed to overcome the 
limitations of traditional simulations: 
which may struggle to explore rare 
events, transitions between 
different states, or high-dimensional 
spaces efficiently. 

These methods aim to enhance 
the sampling of relevant regions 
in the configuration space, 
providing more accurate and 
comprehensive insights into the 
behavior of the system. 



Replica exchange method
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Replica Exchange Molecular Dynamics (REMD):

Idea: REMD involves running parallel simulations at different 
temperatures and occasionally swapping configurations 
between neighboring replicas.

Implementation: By exchanging configurations, REMD 
promotes exploration of the entire temperature space, 
facilitating transitions between different energy basins.



Umbrella sampling

Idea: Umbrella Sampling is used to sample a reaction coordinate 
by applying harmonic restraints to the system along that 
coordinate.

Implementation: Windows are defined along the reaction 
coordinate, and simulations are run independently in each 
window. The resulting data are then combined to obtain the free 
energy profile.

1. Definition of Reaction Coordinate: A reaction coordinate is chosen to describe the progress 
of the system throughout the simulation. This could be a distance between specific atoms, an 
angle, or any other coordinate that characterizes the process of interest.

2. Harmonic Restraints: Along the chosen reaction coordinate, harmonic restraints (springs) 
are applied to confine the system to specific values of the coordinate. These restraints prevent 
the system from moving too far away from the chosen values.

3. Simulation in Windows: The simulation is divided into multiple windows along the reaction 
coordinate. In each window, the system is simulated under the influence of the harmonic 
restraint. The strength of the restraint varies between windows, covering the entire range of the 
reaction coordinate.

4. Independent Simulations: Simulations are run independently in each window. These 
simulations sample different regions of the free energy landscape along the reaction coordinate. 
Typically, each window is equilibrated before production runs.

5. Biasing Potential: The biasing potential applied to the system is essentially a harmonic 
potential due to the restraints. This potential introduces a bias along the reaction coordinate, 
making it easier for the system to explore different states.

6. Sampling in Each Window: In each window, the system samples the region around the 
constrained value of the reaction coordinate. The biasing potential helps overcome energy 
barriers, allowing the system to explore different conformations.

7. Combining Data: The data from simulations in each window are combined to construct the 
overall free energy profile along the reaction coordinate. This is typically achieved by using the 
Weighted Histogram Analysis Method (WHAM) or other similar methods.

8. Free Energy Profile: The resulting free energy profile provides information about the 
thermodynamics of the system along the chosen reaction coordinate. It reveals the relative 
stability of different states and the energy barriers between them.



Accelerated Molecular Dynamics
Accelerated Molecular Dynamics (aMD) is an 
enhanced sampling technique used in molecular 
dynamics simulations to overcome energy barriers and 
explore conformational space more efficiently. The 
primary idea behind aMD is to selectively boost the 
potential energy of the system in regions of high energy, 
making it easier for the simulation to overcome barriers 
and sample rare events.
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Potential Energy Boosting: In traditional molecular dynamics simulations, the potential energy surface may have 
high-energy barriers that slow down the exploration of certain regions of conformational space. Accelerated 
Molecular Dynamics addresses this issue by applying a biasing potential to selectively boost the potential energy in 
high-energy regions.

Boosting Function: A boosting function is defined to modulate the potential energy. This function is typically based 
on the potential energy of each atom or a collective variable. The boosting function is designed to be higher in 
regions of high potential energy, effectively reducing energy barriers.

Boosted Force Calculation: The boosted potential energy modifies the forces acting on the atoms. The forces 
experienced by the atoms are adjusted based on the boosting function, making it easier for the system to explore 
high-energy states.

Simulation Setup: The simulation is set up similarly to traditional molecular dynamics, with an initial configuration, 
force field, and integration algorithm. The only difference is the inclusion of the boosting function in the potential 
energy calculations.

Sampling: The simulation proceeds with the modified potential energy, allowing the system to explore regions that 
would be energetically unfavorable in traditional simulations. The boosted potential energy helps overcome barriers 
and facilitates the sampling of rare events.

Equilibration and Production Runs: The simulation typically starts with an equilibration phase to allow the system 
to adjust to the modified potential energy. After equilibration, production runs are performed to collect data for 
analysis.

Analysis: Trajectories from the simulation are analyzed to extract information about the system's behavior, such as 
structural changes, thermodynamic properties, and the exploration of different conformational states.

Applications: Accelerated Molecular Dynamics is applied to study various biological and chemical processes, 
including protein folding, ligand binding, and conformational changes. It is particularly useful for simulating rare 
events that occur on longer timescales.

Challenges: While aMD can be a powerful tool for enhancing sampling, care must be taken in choosing the 
boosting function and parameters to ensure that the accelerated dynamics do not introduce artifacts. Validation 
against experimental data or other simulation methods is essential.



Collective variable

A collective variable is a descriptor of the molecular system studied predefined by the user. 

It must be a differentiable function of the atomic coordinates. Furthermore, its value should 

reflect the state of the simulated system, including metastable states
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Steered Molecular Dynamics (SMD) is a simulation technique used to study the behavior of a system by 

applying external forces to specific atoms or groups of atoms, often to mimic a pulling or stretching action. 

This method is particularly useful for investigating processes such as protein unfolding, ligand binding, or 

other conformational changes in biological molecules

Steered molecular dynamics (SMD)

3350 SMD simulations 

Idea: In SMD, external forces are applied to specific atoms or 
groups of atoms, effectively guiding the system along a 
particular reaction coordinate.

Implementation: Forces are applied to mimic an experimental 
process (e.g., ligand binding or unfolding of a protein) to 
explore the associated energy landscape.



Metadynamics
Metadynamics involves enhanced sampling over collective variables using a biased potential to force the system to 

leave local minima and thus sample low-probability states (Laio and Parrinello, 2002). Metadynamics is an adaptive 

method, automatically biasing configurations away from those most visited.
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Idea: Metadynamics adds a 
history-dependent bias potential to 
the potential energy surface, 
encouraging the system to explore 
regions that are rarely visited.

Implementation: Gaussian 
potentials are added along chosen 
collective variables. As the 
simulation progresses, these 
Gaussians are deposited, 
preventing the system from 
revisiting the same states.



Supervised Molecular Dynamics (SuMD)

Supervised MD (SuMD) is a computational method that enables the exploration of ligand–receptor 
recognition pathway in a reduced timescale. 

It involves integrating machine learning models, often neural networks, with molecular dynamics 
simulations to improve the accuracy and efficiency of the simulations.

Prediction Step: At each simulation step, the current state of the system (positions, velocities, etc.) is 
input into the trained machine learning model. The model predicts the desired property or behavior based 
on the current state.

Influence on Dynamics: The predicted information is used to guide or influence the dynamics of the 
simulation. This can involve adjusting forces acting on particles, modifying the potential energy landscape, 
or altering other parameters to match the predicted behavior.
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Coarse grained molecular dynamics

Coarse-grained molecular dynamics (CGMD) is a simulation technique that simplifies the 
representation of molecular systems by grouping multiple atoms into a single interaction site. 
This approach reduces the computational cost and allows for the simulation of larger and 
longer time-scale processes compared to all-atom simulations.

 Coarse-grained models are widely used for molecular modeling of biomolecules at various 
granularity levels.

● Allows us to model extremely large systems
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Take-home message

1) Molecular dynamics (MD) is a computer simulation method for analyzing the physical movements 
of atoms and molecules.

2) Molecular dynamics gives us more accurate information about molecular interaction than docking

3) Molecular dynamics allows us:
● to explore dynamic evolution of the system (flexibility of protein, protein-ligand complex, etc.)
● to calculate binding free energy
● to explore conformation space
● to explore protein-ligand (protein-protein) interaction profile

4) The accuracy of the simulation depends on the choice of an appropriate force field, and validation 
against experimental data is crucial.
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Sources:

● GROMACS documentation -  
http://manual.gromacs.org/documentation/2016/index.html

● GROMACS reference manual - 
http://manual.gromacs.org/documentation/2016/manual-2016.pdf

● J. Lemkul tutorials – http://www.mdtutorials.com/gmx/index.html

38
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High-throughput MD



Aim: to implement an easy to use tool to run whole pipeline of 
Molecular Dynamics simulation automatically  

Structure Preparation
● add missing atoms
● protonation
● etc

Force-field
● Definitions of inter-atomic bonded and 

non-bonded forces

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization

NVT and NPT equilibration
● 1000 ps

Product Simulation

Analysis

Preprocessing

Pre-simulation 
steps

Perform High-Throughput Molecular Dynamics

Rank compounds by:
● Stability of previously obtained pose of ligand
● Calculated Binding Energy
● Stability of protein-ligand contacts 40



Main features of the tool:
● User control of simulation time 

○ from 10 ps to 1 µs

● Default preset optimal parameters to run Molecular Dynamics

○ can be easily modified

○ useful as teaching source 

● Support of modeling of different molecular systems

○ protein only, protein-ligand, protein-ligand-cofactors

● Support of simulation of boron-containing molecules (Gaussian-based calculations)

● Support of simulation with parameterized by MCPBPY metal atoms

● Automatic analysis of simulation:

○ RMSD plots for both protein and ligand objects

○ Plot of flexibility of each amino acids (RMSF)

● Support of analysis by additional instruments:

○ ProLIF: Ligand-Protein interactions (time-dependent function, stability analysis)

○ MM(PB)GBSA: Calculation of Binding Energy

Protein

Protein-Ligand

Protein-Ligand-Cofactor41
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Classical Molecular Dynamics
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Structure Preparation

Force-field
● Definitions of inter-atomic bonded and 

no-bonded forces (ligand and protein)

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization
● 100 ps
● to ensure that the system has no steric 

clashes or inappropriate geometry

NVT and NPT equilibration
● 1000 ps
● equilibrate the solvent and ions around the 

protein

Product Simulation

Analysis

Pre-simulation 
steps

Preprocessing



Protein preparation

44
https://www.cgl.ucsf.edu/chimera/



Protein preparation
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1. Download structure from PDB (https://www.rcsb.org/) using PDBID

Download Files -> PDB Format

https://www.rcsb.org/


Protein preparation
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1. Download structure from PDB (https://www.rcsb.org/) using PDBID

Download Files -> PDB Format

2. Download sequence from PDB or from UniProt

Download Files -> Fasta Sequence

https://www.rcsb.org/


Protein preparation
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1. Download structure from PDB (https://www.rcsb.org/) using PDBID

Download Files -> PDB Format

2. Download sequence from PDB or from UniProt

Download Files -> Fasta Sequence

3. Save smiles of ligand into file (ligand.smi)

https://www.rcsb.org/


Protein preparation
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4. Open Fasta and PDB in Chimera

a. Dock Prepare

Structure Editing -> Dock Prep



Protein preparation
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4. Open Fasta and PDB in Chimera

b. fill missing loops by Modeller

Tools -> Sequence -> Sequence

Sequence -> Structure -> Modeller (loops/refinement)

c. add Hs to selected model

select the model with 
the lowest zDOPE



Protein preparation
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4. Open Fasta and PDB in Chimera

d. Set HIS protonated state

Tools -> General Controls -> Command line

Put in the Command line:

setattr r type HID :HIS@HD1,DD1,TD1,HND
setattr r type HIP :HID@HE2,DE2,TE2
setattr r type HIE :HIS@HE2

https://ambermd.org/Questions/HIS.html

HIS84 HIE84

check visually active site



Chimera preparation
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4. Open Fasta and PDB in Chimera

e. Save protein only (plus ions, metals) and ligand only in pdb formats separately

Select -> Residue -> Ligand_id

File -> Save PDB -> Save selected only

ligand.pdb

Select -> Invert (all models)

File -> Save PDB -> Save selected only

protein_prepared.pdb



Ligand preparation
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5. Save protonated smiles (pH 7.4) by Marvin into ligand_74.smi

Open Marvin Sketch

File -> Open -> ligand.smi

Calculations -> Protonation -> Major Microspecies -> 7.4 -> Ctrl+L (copy as Smiles)

Save to ligand_74.smi



Ligand preparation
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6. Transform pdb of ligand into mol format (add bonds information from smiles)

Script https://github.com/ci-lab-cz/md-scripts/blob/master/scripts/pdb2mol.py

Run in Bash/Shell: 

python md-scripts/scripts/pdb2mol.py -i ligand.pdb --smiles ligand_74.smi  -o ligand.mol

https://github.com/ci-lab-cz/md-scripts/blob/master/scripts/pdb2mol.py


Protein Ligand preparation
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Input Files for MD:

protein_prepared.pdb

- no missing non-terminal atoms/residues
- removed non-protein residues
- added all hydrogens
- set HID/HIE/HIP states of HIS

ligand.mol

- protonated at 7.4 pH
- added all hydrogens



Classical Molecular Dynamics
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Structure Preparation

Force-field
● Definitions of inter-atomic bonded and 

no-bonded forces (ligand and protein)

Simulation box setup
● box size/shape

Solvate system
● add HOH molecules

Neutralize system
● add NA+/CL- ions

Energy minimization
● to ensure that the system has no steric 

clashes or inappropriate geometry

NVT and NPT equilibration
● 1000 ps
● equilibrate the solvent and ions around the 

protein

Product Simulation

Analysis

Pre-simulation 
steps

Preprocessing

https://github.com/ci-lab-cz/md-scripts



Practice: force fields
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https://manual.gromacs.org/documentation/current/onlinehelp/gmx-pdb2gmx.html

New files:
protein.gro: a molecular 
structure in Gromos87 format.
topol.top: molecular topology
posre.itp: position restraints

gmx pdb2gmx -f protein.pdb -o protein.gro -water tip3p -ignh <<< “AMBER99SB-ILDN” 

Prepare the protein topology with pdb2gmx



Practice: force fields
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https://manual.gromacs.org/documentation/current/onlinehelp/gmx-pdb2gmx.html

gmx pdb2gmx -f protein.pdb -o protein.gro -water tip3p -ignh <<< “AMBER99SB-ILDN” 

Prepare the protein topology with pdb2gmx

pdb2gmx does not work on ligand



Automation tools for ligand topology

58



Practice: water model
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https://manual.gromacs.org/documentation/current/onlinehelp/gmx-pdb2gmx.html

gmx pdb2gmx -f protein.pdb -o protein.gro -water tip3p -ignh <<< “AMBER99SB-ILDN” 

TIP3P - 3-site rigid water molecule with 
charges and Lennard-Jones parameters 
assigned to each of the 3 atoms.



Ligand Force fields

Prepare the ligand topology using external tools

antechamber -i ligand.pdb -fi pdb -o lig.mol2 -fo mol2 -c bcc -pf y -s 2
parmchk2 -i lig.mol2 -f mol2 -o lig.frcmod
python pmed_amb2gmx.py -p lig.prmtop -x lig.inpcrd -o UNL

Build the topology for the protein-ligand system
Insert a line that says #include lig.itp" into topol.top after the position restraint file is included
Make adjustments is in the [ molecules ] directive

60

New files: 
lig.mol2 - file of ligand with charges and bonds
lig.frcmod - Parameter modification file
posre_ligand.itp - positional restraints
ligand.gro - ligand in Gromos87 format
ligand.inpcrd - Amber coordinate file of ligand
ligand.prmtop - Amber topology file
ligand.top - Gromacs topology file

Changed files: topol.top



Solvation
To perform simulation we should add water molecules to mimic real environment.

There are two steps to defining the box and filling it with solvent:

1) Define the box dimensions using the editconf module
2) Fill the box with water using the solvate module.

We will use a simple cubic box as the unit cell.
First define the box using editconf:
    gmx editconf -f protein.gro -o protein_newbox.gro -c -d 1.0 -bt cubic

a solute-box distance of 1.0 nm will mean that there are at least 2.0 nm between any two periodic images 
of a protein. This distance should be sufficient for just about any cutoff scheme commonly used in 
simulations.

61

New files: 
protein_newbox.gro: protein+box system



Solvation
To perform simulation we should add water molecules to mimic real environment.

On the previous step we have defined a box, then we should fill it with solvent (water). Solvation is 
accomplished using solvate command:

gmx solvate -cp protein_newbox.gro -cs spc216.gro -o protein_solv.gro -p topol.top

-cp - the configuration of the protein (-cp)

-cs - the configuration of the solvent (-cs)

spc216.gro is a generic equilibrated 3-point solvent model (suitable for SPC, SPC/E, or TIP3P water, 
since they are all three-point water models)
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New files: 
protein_solv.gro: protein + solvent system
Changed files: 
topol.top



Adding ions

We need to add ions of CL- or NA+ to neutralize our protein:

     gmx grompp -f ions.mdp -c protein_solv.gro -p topol.top -o ions.tpr

     gmx genion -s ions.tpr -o protein_solv_ions.gro -p topol.top -pname NA -nname CL -neutral
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Solvated protein with ions
New files: 
protein_solv_ions.gro: protein + solvent + 
ions system
ions.tpr: portable binary run input file. This 
file contains the starting structure, the 
molecular topology and all the simulation 
parameters. 

Changed files: topol.top



Energy minimization

Before we can begin dynamics, we must ensure that the system has no steric clashes or inappropriate 
geometry (equilibrium state). The structure is relaxed through a process called energy minimization 
(EM).

Prepare files:

 gmx grompp -f minim.mdp -c protein_solv_ions.gro -p topol.top -o  em.tpr

Run the minimization:

 gmx mdrun -v -deffnm em –s em.tpr
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New files: 
em.log: ASCII-text log file of the EM process
em.edr: Binary energy file
em.tpr: Contains the starting structure, the molecular topology and all the simulation parameters.
em.trr: Binary full-precision trajectory
em.gro: Energy-minimized structure



How to do an analysis:
The em.edr file contains all of the energy terms that GROMACS collects during 
EM. You can analyze any .edr file using the GROMACS energy module:

gmx energy -f em.edr -o potential.xvg << "Potential" 

65

Energy minimization

Epot should be negative, and (for a 
simple protein in water) on the 
order of 105-106

maximum force, Fmax, "emtol = 
1000.0" should be no greater than 
target 1000 kJ mol-1 nm-1.



Equilibration

Energy Minimization ensured that we have a reasonable starting structure, but to 
begin real dynamics, we must equilibrate the solvent and ions around the protein.
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Why do we need equilibration?

If we were to attempt unrestrained dynamics at this point, the system may collapse.

 The reason is that the solvent is mostly optimized within itself, and not necessarily with the 
solute. It needs to be brought to the temperature we wish to simulate and establish the 
proper orientation around the solute (the protein). After we achieved the correct temperature 
(based on kinetic energies), we will apply pressure to the system until it reaches the proper 
density.
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Controlling the system

68https://web.mst.edu/~vojtat/class_5403/MolecularDynamics.pdf



Restrain the system

To equilibrate the solvent and ions around the protein we need to apply position 
restraints on the heavy atoms of the protein.

The purpose of posre.itp is to apply a position restraining force on the heavy 
atoms of the protein (anything that is not a hydrogen). Movement is permitted, but 
only after overcoming a substantial energy penalty.
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NVT equilibration

70https://web.mst.edu/~vojtat/class_5403/MolecularDynamics.pdf

In MD simulation: some state variables 
are external parameters, others are 
observables to be calculated



NVT equilibration

to run NVT equlibration:

gmx grompp -f nvt.mdp -c em.gro -r em.gro -p topol.top -o nvt.tpr 

gmx mdrun -deffnm nvt -s nvt.tpr

An analysis:

gmx energy -f nvt.edr -o temperature.xvg <<< “Temperature”
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New files: 
nvt.log: ASCII-text log file of the equilibration process
nvt.edr: Binary energy file
nvt.trr: Binary full-precision trajectory
nvt.gro: NVT-minimized structure



NPT equilibration

72https://web.mst.edu/~vojtat/class_5403/MolecularDynamics.pdf



NPT equilibration
Note that we are now including the -t flag to include the checkpoint file from the NVT equilibration

The coordinate file (-c) is the final output of the NVT simulation.

to run NPT equlibration:

gmx grompp -f npt.mdp -c nvt.gro -r nvt.gro -t nvt.cpt -p topol.top -o npt.tpr gmx mdrun -deffnm npt 
-s npt.tpr

An analysis:

    gmx energy -f npt.edr -o pressure.xvg <<< ”Pressure”

    gmx energy -f npt.edr -o density.xvg <<< “Density”
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New files: 
nvt.log: ASCII-text log file of the equilibration process
nvt.edr: Binary energy file
nvt.trr: Binary full-precision trajectory
nvt.gro: NVT-minimized structure



NPT equilibration

74In our tool we run 1000 ps NPT equilibration by default
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Periodic boundary conditions (PBCs) 
are a set of boundary conditions which 
are often chosen for approximating a 

large (infinite) system by using a small 
part called a unit cell. 

● PBCs are often used in computer 
simulations and mathematical models.

● The topology of two-dimensional PBC is 
equal to that of a world map of some 
video games; the geometry of the unit 
cell satisfies perfect two-dimensional 
tiling, and when an object passes 
through one side of the unit cell, it 
reappears on the opposite side with the 
same velocity.



Production MD
the system is now well-equilibrated at the desired temperature and pressure. We are now ready to release 
the position restraints and run production MD

We will run MD simulation

gmx grompp -f md.mdp -c npt.gro -t npt.cpt -p topol.top -o md_0_1.tpr

gmx mdrun -deffnm md_0_1 -s md_0_1.tpr
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New files: 
md_0_1.tpr: portable binary run input file. It contains the starting structure of 
the simulation, the molecular topology and all the simulation parameters.
md_0_1.log: ASCII-text log file of the equilibration process
md_0_1.cpt: portable checkpoint file. The complete state of the simulation is 
stored in the checkpoint file, including extended thermostat/barostat variables, 
random number states and NMR time averaged data
md_0_1.edr: Binary energy file
md_0_1.xtc: Binary full-precision trajectory
md_0_1.gro: starting structure of the simulation in  



Analysis of calculated MD simulation

Remove PBC:

gmx trjconv -s md_out.tpr -f md_out.xtc -pbc nojump -o md_out_noj_noPBC.xtc <<< 
"System"

Center system:

gmx trjconv -s md_out.tpr -f md_out_noj_noPBC.xtc -o md_centermolsnoPBC.xtc -pbc mol 
-center -n index.ndx <<< "Protein_UNL System"

Alignment of all frames (Remove rotations and translations):
gmx trjconv -s md_out.tpr -f md_centermolsnoPBC.xtc -fit rot+trans -o md_fit.xtc -n index.ndx 
<<< "Protein_UNL System"

77



RMSD:

gmx rms -s md_0_1.tpr -f md_0_1_noPBC.xtc -o rmsd.xvg -tu ns

 RMSF:

gmx rmsf -s md_0_1.tpr -f md_0_1_noPBC.xtc -o rmsf.xvg -oq rmsf.pdb -res

Analysis of calculated MD simulation
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xmgrace
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Output files:
md_out.tpr: portable binary run input file. It contains the starting structure of the simulation, the molecular topology and all the 
simulation parameters.
md_out.log: ASCII-text log file of the equilibration process
md_out.cpt: portable checkpoint file. The complete state of the simulation is stored in the checkpoint file, including extended 
thermostat/barostat variables, random number states and NMR time averaged data
md_out.edr: Binary energy file
md_out.xtc: Binary full-precision trajectory
md_out.gro: starting structure of the simulation

md_fit.xtc:  fitted trajectory (removed PBC and the rotation and translation, centered) to use for rmsd and energy calculation 
analysis
md_short_forcheck.xtc: fitted short trajectory (each 100 step is skipped)
frame.pdb: a frame from the trajectory to provide topology

MD trajectory analysis files:
rmsd.xvg - rmsd of Backbone of protein
rmsd_UNL.xvg - rmsd of the heavy atoms of ligand
gyrate.xvg - radius of gyration of the protein
rmsf.xvg - root mean square fluctuation of each amino acids

MD simulation by one command:
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Check your own MD trajectory

frame.pdb - a frame from the trajectory to provide topology 
md_fit.xtc - your fitted MD trajectory 
md_short_forcheck.xtc - short part of the simulation



Analysis of calculated MD simulation
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LigandProtein

1 ns



Analysis of the calculated MD simulation
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MMPBSA / MMGBSA
End-state free energy calculations 

with GROMACS files
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What can be done by MD
● to estimate binding affinity of 

protein-ligand complexes
○ Molecular mechanics Poisson–Boltzmann 

surface area (MM/PBSA)
○ Molecular mechanics generalized Born surface 

area (MM/GBSA) 

Valdés-Tresanco, M.S., Valdés-Tresanco, M.E., Valiente, P.A. and Moreno E. gmx_MMPBSA: A New Tool to Perform End-State Free Energy Calculations 
with GROMACS. Journal of Chemical Theory and Computation, 2021 17 (10), 6281-6291. https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645. 
MMPBSA.py: An Efficient Program for End-State Free Energy Calculations  Bill R. Miller III, T. Dwight McGee Jr., Jason M. Swails, Nadine Homeyer, Holger 
Gohlke, and Adrian E. Roitberg  Journal of Chemical Theory and Computation 2012 8 (9), 3314-3321 DOI: 10.1021/ct300418h
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https://pubs.acs.org/doi/10.1021/acs.jctc.1c00645


What can be done by MD
● to estimate binding affinity of 

protein-ligand complexes
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Total GBinding=
● Gas-phase molecular mechanics energy ΔEMM:

○ changes in the internal energies ΔEint (bond, angle, and 
dihedral energies)

○ electrostatic energies ΔEele

○ van der Waals energies ΔEvdW

● sum of the electrostatic solvation energy Gsol
○ The polar contribution is calculated using either the PB 

or GB model (ΔGPB/GB). Where the GB method gives an 
analytical expression for the polar solvation energy and is 
thus much faster than the PB method.

○ nonpolar energy is usually estimated using the 
solvent-accessible surface area (SASA)

● The change in conformational entropy −TΔS 
○ is usually calculated by normal-mode analysis (or 

Interaction entropy) on a set of conformational snapshots 
taken from MD simulations.
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run_gbsa -i mdrun/md_files/md_run/protein_HIS_ligand_1/

MMPBSA.in
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GENERALIZED BORN:
POISSON BOLTZMANN:

MMPBSA Energy and MMGBSA 
Energy cannot be compared within the 

different methods. But you can rank 
your molecules by energies obtained 

from each method separately.

PBSA

GBSA
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1KE61KE5 1KE7

IC50: 560 nM
Vina: -8.7
GBSA (0.1 ns): -30.7
GBSA (1 ns): -25.8

IC50: 5.7 nM
Vina: -8.9
GBSA (0.1ns): -23.3
GBSA (1ns): -21.5

CYCLIN-DEPENDENT KINASE 2 (CDK2)

IC50: 8.9 nM
Vina: -9.6
GBSA (0.1ns): -19.3
GBSA (1ns): -27.1
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Thank you for your attention!


